
GRADE 6 

Research based projects 

This file comprises of 5 research based projects, each student will do only one project 

according to the roll no.’s assigned. 

 

1. Symmetry in Real Life Geometry Application Project (Roll no. 1-7) 

Output: Symmetry Scrapbook 

Skills: Geometry, observation, visual reasoning, creativity 

Purpose of the Project: “Symmetry in Real Life – Geometry Application” 

The purpose of the Symmetry in Real Life project is to help students understand the concept 

of symmetry by identifying and exploring it in their surroundings. Through observation and 

collection of real-life examples, students learn how symmetry is not only a mathematical idea 

but also an important part of nature, art, architecture, and everyday objects. 

This project aims to: 

• Connect geometry concepts with real-world applications 

• Develop visual reasoning by recognizing lines of symmetry in objects 

• Strengthen observation skills through careful looking and selection 

• Encourage creativity through the design of a symmetry scrapbook 

• Help students appreciate the beauty and balance created by symmetry 

Objectives 

• Understand the concept of symmetry (line symmetry, rotational symmetry, reflective 

symmetry). 

• Identify examples of symmetry in natural objects, buildings, patterns, everyday 

objects, and logos. 

• Develop observation skills by finding symmetry in the real world. 

• Create a visual scrapbook demonstrating different types of symmetry. 

• Apply geometric concepts to real-life contexts through analysis and explanation. 

Revision of Symmetry Concepts 

Types of Symmetry  

• Line (Mirror) Symmetry: A line divides an object into two identical halves. 

• Rotational Symmetry: An object looks the same after rotating it by a certain angle 

(e.g., 90°, 180°). 

• Point Symmetry (optional): Each part has an identical part opposite to a central 

point. 



Include a page in the scrapbook explaining these types using simple drawings. 

Collecting Real-Life Examples 

Students must collect or photograph at least 10–15 examples across categories. 

Nature 

• Butterfly wings (line symmetry) 

• Leaves with central midrib 

• Flowers with radial/rotational symmetry (e.g., daisies, sunflowers) 

• Starfish (rotational) 

• Snowflakes (six-line symmetry) 

Architecture & Buildings 

• Jamia Masjid, Taj Mahal etc 

• Windows & door designs 

• Arches and domes 

• Floor tiles or geometric patterns 

• Bridges with symmetrical structures 

Logos & Objects 

• School logo 

• Apple logo (near symmetry but slightly stylized) 

• Mercedes-Benz logo (rotational symmetry) 

• Adidas logo (pattern symmetry) 

• Pepsi logo (approximate symmetry) 

• Playing cards, mandalas, rangoli patterns 

Students can cut pictures from magazines, print photos, or draw the examples. 

Step-by-Step Instructions to Create the Scrapbook 

Title Page 

Include: 

• Project name 

• Student name, class 

• A simple geometric design demonstrating symmetry 

Explanation Page 

Write short definitions: 

• What is symmetry? 

• Types of symmetry with diagrams. 



Example Pages (Main Content) 

For each picture or drawing: 

1. Paste the image neatly. 

2. Draw the line of symmetry using a ruler (or indicate rotational symmetry). 

3. Label the type of symmetry: 

o “Line Symmetry (Vertical)” 

o “Line Symmetry (Horizontal)” 

o “Rotational Symmetry – order 3,” etc. 

4. Add a short description explaining: 

o Why this example shows symmetry 

o Where the picture was taken/found (optional) 

Suggested structure for each page: 

Picture → Line of Symmetry → Type → Short Explanation 

Category Pages 

Create sections such as:  

• Nature Symmetry 

• Building/Architecture Symmetry 

• Logo & Design Symmetry 

Add 3–5 examples in each section. 

Creative Page (Optional) 

Students may include: 

• Handmade symmetrical art 

• Cut-and-fold paper symmetry 

• Mandala designs 

• Symmetrical rangoli patterns 

This adds a fun artistic element. 

Conclusion Page 

Write a short reflection: 

• Where do you see symmetry most often in daily life? 

• Why is symmetry important in design, nature, and mathematics? 

• What did you learn? 

Sample Observation Table (Optional for Students) 

Example Category Type of Symmetry Notes 



Leaf Nature Line symmetry …. 

Window Architecture Vertical symmetry ……. 

Mercedes logo Logo Rotational symmetry …….. 

 

Learning Outcomes 

By the end of this activity, students will be able to: 

• Identify real-life examples of line and rotational symmetry. 

• Draw and label lines of symmetry correctly. 

• Explain symmetry using geometric vocabulary. 

• Recognize the role of symmetry in nature, art, and design. 

• Organize information creatively into a well-presented scrapbook. 

2. Math in Sports — Cricket Analysis Project (Roll no. 8-14) 

(Angles • Scoring Patterns • Graphs • Applied Mathematics) 

Purpose of the Research Project: 

The purpose of this project is to demonstrate how mathematical concepts are practically 

applied in the game of cricket to analyze performance, strategy, and outcomes. The study 

aims to examine the role of angles in batting shots and field placements, scoring patterns 

across overs and formats, and the use of graphs and statistics to evaluate players’ and 

teams’ performances. 

By analyzing real match data, the project seeks to show how applied mathematics helps in 

decision-making, such as optimizing shot selection, predicting run rates, assessing strike 

efficiency, and planning bowling strategies. Graphical representations like bar graphs, line 

graphs, and pie charts will be used to interpret trends and patterns in scoring and 

performance. 

Ultimately, this project aims to connect classroom mathematics with real-life sports 

applications, enhance analytical and data-interpretation skills, and promote interest in 

mathematics by illustrating its relevance, practicality, and importance in modern sports 

analytics. 

Project Overview 

Cricket involves a lot of mathematics—angles of batting shots, distances covered, scoring 

rates, acceleration, and momentum. 

In this project, students analyze scoring patterns in a cricket innings to understand how 

mathematics describes real‐world sports performance. 

Key Skills: 

• Data handling 



• Applied arithmetic 

• Rates & ratios 

• Graph interpretation 

• Basic statistics 

• Geometry in sports 

Detailed Step-by-Step Instructions 

Collect or Use Sample Match Data 

• Watch a real match and record runs per over 

 

Calculate Key Mathematical Quantities 

Create the following columns: 

1. Cumulative Runs 

Add each over’s runs to all previous overs. 

2. Cumulative Run Rate 

Ratio of cumulative runs and number of overs 

3. ΔRuns (Change per Over) 

Difference of runs in consecutive overs gives change per over. Helps detect 

momentum shifts. 

4. 3-Over Moving Average 

Average of three consecutive overs it smooths the data: 

Fill the Calculation Table 

Calculation Table  

Over Runs Cumulative CRR ΔRuns 
3-Over 

Moving Avg 

1 … … … … …. 

2      

3      

4      

Over runs 

1 .. 

2 .. 

3 .. 

4 .. 

… .. 

… .. 

… .. 



5      

6      

7      

Create Graphs 

Use two types of graphical representation: 

Graph 1: Cumulative Score vs Over 

Shows how the score grows; slope represents momentum. 

Graph 2: Runs per Over (Bar Graph) 

Shows high-scoring and low-scoring overs. 

Interpret the Data 

Add text on your poster explaining insights: 

A. Scoring Patterns 

• Highest scoring over = Over 13 (16 runs) 

• Lowest scoring over = Over 11 (0 runs) 

• Steady acceleration in overs 6–7 

• Big slump at Over 8 (from 15 → 1) 

B. Momentum Analysis (ΔRuns) 

• Sharpest momentum gain: +12 (Over 12 → 13) 

• Sharpest slowdown: −14 (Over 7 → 8) 

C. Phase Analysis 

• Powerplay (Overs 1–6): 41 runs → 6.83 rpo 

• Middle Overs (7–15): 67 runs → 7.44 rpo 

• Death Overs (16–20): 44 runs → 8.8 rpo 

Geometry Component (Angles in Cricket) 

Add a small geometry section: 

Batting angles 

• Cover drive ≈ 30° 

• Square cut ≈ 90° 

• Pull shot ≈ 120° 

• Hook shot ≈ 135° 

Students can: 



• draw the field layout 

• mark angles of common cricket shots 

• show how angle affects distance. 

Vector analysis idea 

Shot direction = angle 

Shot distance = magnitude 

→ Represent shots as arrows from the pitch. 

 Math in Sports – Cricket Performance Analysis 

Sections to include: 

1. Graphs 

o Cumulative runs graph 

o Runs-per-over graph 

2. Calculation Table 

(use the one provided above) 

3. Key Findings 

o Best/worst overs 

o Momentum shifts 

o Phase analysis 

4. Angles in Cricket 

o diagram of field 

o 30°, 60°, 90°, 120° shot angles 

5. Conclusion 

Cricket scoring can be understood using mathematics: averages, rates, slopes, angles, 

and data interpretation. 

Learning Outcomes 

By completing this project, students will be able to: 

Mathematical Skills 

• Compute averages, run rates, and cumulative values 

• Interpret line and bar graphs 

• Analyze rate of change using ΔRuns 

• Use moving averages to smooth data 

• Recognize patterns and anomalies 

Sports Analysis Skills 

• Understand scoring momentum 

• Identify strategic phases of a cricket innings 

• Connect mathematical trends with actual game decisions 

• Understand how angles influence batting shots 

General Skills 



• Data interpretation 

• Critical thinking 

• Applying mathematics to real-life situations 

• Presenting information visually in a poster 

3. Project: Water Purification Methods  Filtration vs Sedimentation vs Boiling 

 (Roll no. 15-22) 

Project Title 

Comparison of Water Purification Methods: Filtration, Sedimentation & Boiling. 

Purpose of this project 

• It combines theory + practical work — not just reading about water purification, but 

actually doing and seeing effects. 

• It’s relatable and relevant — many students live in areas where water is not always 

clean; this project helps understand how they (or their community) can purify water. 

• It fosters scientific literacy and awareness — understanding contaminants, why 

water needs treatment, and safe practices. 

• It builds real-world life skills — awareness of hygiene, health, resourcefulness, even 

simple engineering (filter building). 

• It’s scalable — even if you don’t have fancy equipment, you can use simple local 

materials (cloth, sand, bottles, pot). 

Objectives / Goals 

Main Objective:  

• To understand and compare how different simple water-purification methods 

filtration, sedimentation, and boiling work, and to evaluate their strengths and 

limitations. 

Secondary Objectives / Skills to Develop: 

• Apply scientific method: plan, observe, record, compare results. 

• Learn about water impurities and how physical/thermal processes remove them. 

• Develop data-collection and analytical skills. 

• Build a small model / demonstration showing water purification steps. 

• Develop awareness about safe water use and public-health importance. 

Real-Life / Practical Relevance: 

• Helps understand how to make water safer for drinking when clean supply is not 

available. 

• Useful in rural or resource-limited areas, or in emergencies. 

• Promotes hygiene and health awareness. 

 



  

Materials / Resources Needed 

• Three identical transparent containers (e.g. plastic bottles or glass jars) — labelled  A, 

B, C. 

• Funnel + filter medium (filter paper, or clean cloth/muslin cloth / fine sand + gravel + 

cloth) — for filtration. 

• Muddy water sample (or water + some soil/sand to simulate dirty water). 

• Stirrer (spoon or stick). 

• Heat source and pot (for boiling) — stove/coal stove/earthen stove etc. 

• Clean beakers or clean containers to collect purified water. 

• Thermometer (optional, if available). 

• Measuring cups/measuring cylinder. 

• Notebook or observation sheet / table for recording observations. 

• (Optional) pH/micro-organism testing strips  if available  to test water quality 

differences. 

  

Step-by-Step Plan / Experimental Procedure 

Methods:  

Sedimentation 

 Fill container A with the muddy water sample. 

Stir well so particles are suspended. Then leave the container undisturbed for a fixed time 

(e.g. 1–2 hours), or until sediment settles visibly at the bottom. 

After settling, carefully decant (pour out) the top water into a clean beaker — try not to 

disturb sediments. 

Observe and note clarity (visual), colour, amount of sediment settled, approximate clarity 

difference compared to original. 

Filtration 

Take container B with the same muddy water sample (same as for sedimentation). 

Use a funnel lined with filter medium (filter-paper / cloth / sand + cloth) and slowly pour the 

water through into a clean beaker. 

Collect the filtrate (the water passed through filter). Observe and note clarity, whether 

particles are visible/absent, turbidity, and compare with original water and sedimentation 

output. 

Boiling 

 

 Take container C with muddy water sample. 

 Pour into a pot, heat over stove until water reaches boiling point (near 100°C) and let boil 

for at least 1–3 minutes (depending on altitude — longer if high altitude) to kill microbes. 3. 

Let water cool, then pour into a clean container. Observe clarity, smell, any change in 



appearance compared to original water. Note that boiling kills microbes but does not 

remove suspended mud/particles.  

Important: 

 Use the same muddy water sample for all three methods (so initial contamination is same). 

Do the experiments at roughly similar times/conditions — this helps make comparisons fair. 

 

 

 

Data / Observations / Logs 

Prepare a table like this in your notebook or chart paper: 

Method Time 

used / 

Duration 

Visual 

clarity 

after 

treatment 

Visible 

particles 

/ 

sediment 

/ 

turbidity 

Smell / 

odour / 

any 

change 

Approx 

water 

volume 

recovered 

(if 

different) 

Remarks 

(ease, time, 

resources, 

safety, 

limitations) 

Sedimentation       

Filtration       

Boiling       

If possible  repeat the experiment more than once (with different samples / same sample) to 

check consistency. 

If you have test-kit (for bacteria, pH, turbidity, basic water test) test water after each method 

and record results. 

 

Analysis / Comparison / Reflection 

After collecting data and observations, answer questions like: 

• Which method gave the clearest water (least visible particles/turbidity)? 

• Which method removed solids vs which removed/killed microbes (or could kill 

microbes)? 

• Which method is easiest / cheapest / fastest / safest? 

• Which method needs resources (fuel, filter materials, containers)? 

• What are limitations of each method (e.g. filtration might not remove very fine 

suspended or dissolved particles; boiling does not remove solids; sedimentation slow; 

none removes dissolved chemical pollutants)?  

• Based on these findings — which method (or combination) would you recommend for 

households relying on river/pond water? Why? 



• How practical is each method for daily use — in your locality (consider fuel, 

materials, water turbidity, safety)? 

• What improvements or additional steps could make water safer (e.g. after filtration + 

boiling, after sedimentation + filtration, or adding disinfection)? 

 

Output / Deliverables 

• A comparison table showing all data & observations (as above). 

• A written report or presentation summarizing the experiment, results, analysis, 

comparison, recommendation, limitations, possible improvements. 

• (Optional but good) Photos or sketches showing each step before/after purification 

for visual clarity. 

 

Expected Learning Outcomes 

By doing this project students will: 

• Understand different principles behind water purification (gravity & settling → 

sedimentation; physical barrier → filtration; heat/sterilization → boiling / 

disinfection). 

• Learn about strengths and limitations of simple purification methods — why no one 

method is perfect alone, what types of impurities each removes or fails to remove. 

• Gain practical hands-on skills: building a simple filter model, careful observation, 

data collection, comparison, and experiment documentation. 

• Develop scientific thinking — forming hypothesis (“which method will make water 

clearer / safer?”), testing, observing, comparing, drawing conclusions. 

• Understand public health and environmental importance of clean water, and how 

local or household-level purification can improve safety and health. 

• Enhance presentation & communication skills — through making a 

table/model/report/poster to share findings. 

• Experience problem-solving mindset — dealing with messy water, designing a 

method, evaluating trade-offs (resources vs cleanliness), and thinking of 

improvements. 

4. Weather Study (10-Day Data Project)  (Roll no. 23-30) 

Topic: Temperature & Humidity  

Output: Line graph (or two line graphs) 

Skills: Data collection, organization, charting, interpretation — data science basics. 

Purpose of the Project 

The purpose of this project is to introduce students to systematic data collection and basic 

data analysis by studying daily variations in temperature and humidity over a fixed period 

of time. Through real-time observation and recording of weather data, students learn how 



environmental conditions change from day to day and how these changes can be represented 

mathematically. 

This project aims to develop foundational data science skills, including organizing data in 

tables, representing information using line graphs, and interpreting trends and patterns. By 

comparing temperature and humidity, students also gain an understanding of the relationship 

between different weather parameters and their impact on daily life, health, and the 

environment. 

Overall, the project helps students connect science, mathematics, and data analysis, 

encouraging evidence-based thinking, accuracy in observation, and the ability to draw 

meaningful conclusions from real-world data. 

Objectives 

1. Teach students how to collect and record consistent weather data. 

2. Introduce basic data-cleaning and table organization. 

3. Plot a line graph for time-series data. 

4. Interpret patterns, trends, and anomalies in the graph. 

5. Build foundational data science skills: measurement, visualization, and analysis. 

Materials Needed 

• Weather source (weather app, thermometer, hygrometer, or a reliable website). 

• Pencil/notebook or spreadsheet software (Google Sheets/Excel). 

• Graphing tool (Google Sheets, Excel, or Python/matplotlib if advanced). 

Step-by-Step Instructions (Detailed) 

1. Choose a consistent observation time 

• Pick a time you can check every day (e.g., 8:00 AM). 

• Always record data at this exact time to avoid variability. 

2. Record temperature & humidity daily for 10 days 

Record: 

• Date 

• Temperature (°C or °F — be consistent) 

• Humidity (%) 

• Weather notes (optional: sunny/rainy/cloudy) 

Use a chart like the template below. 

3. Build a clean data table 

Example structure: 



Day Date Temperature 

(°C) 

Humidity (%) Notes 

1     

2     

3 

  

    

…..     

Tips:  

• Keep numbers only (no symbols like "°C" inside the cell). 

• Use whole numbers or one decimal place. 

4. Enter the data into a graphing tool 

If using Google Sheets: 

1. Highlight the columns: Date, Temperature. 

2. Insert → Chart → Chart Type → Line chart. 

3. Repeat for humidity (or plot both on one chart using dual axes if allowed). 

If using Excel: 

1. Select your data. 

2. Insert → Line Chart. 

Optional advanced: 

• Use different line styles 

• Add markers 

• Add chart title, axis labels, legends 

5. Label your graph properly 

A complete graph must include: 

• Title: “Temperature Over 10 Days” 

• X-axis: Dates 

• Y-axis: Temperature (°C) 

• Legend: If graphing both temp & humidity together 

For two separate graphs: 

• Graph 1 → Temperature 

• Graph 2 → Humidity 

6. Analyze & interpret the results 

Write 4–6 sentences answering: 



• Did the temperature rise or fall over time? 

• Is there a pattern (e.g., cooler on cloudy days)? 

• Is humidity related to temperature changes? 

• Were there any sudden spikes or drops? Why might they have happened? 

This part builds reasoning and data-science insight. 

Optional Student Extension Tasks 

• Calculate daily temperature range (max – min). 

• Compare results with a second location. 

• Add precipitation levels or wind speed. 

Learning Outcomes 

Students will be able to: 

• Collect consistent time-series weather data. 

• Organize values in a clean, analysis-ready table. 

• Create a line graph using spreadsheet tools. 

• Identify trends, cycles, and anomalies in weather data. 

• Demonstrate introductory data-science and visualization skills. 

5. Project Title: Evolution of Communication (Roll no. 31-37) 

 

Purpose of the Project 

The purpose of this project is to understand how methods of communication have evolved 

over time and how technological advancements have transformed the way people share 

information. The project aims to help students recognize the importance of communication in 

social, economic, and cultural development, and to analyze how each stage of communication 

improved speed, accessibility, and global connectivity. 

 

Detailed Instructions (Methodology) 

1. Research Phase 

o Collect information from textbooks, reference books, and reliable online 

sources on the following communication methods: 

▪ Letters and messengers 

▪ Telegraph 

▪ Telephone 

▪ Email 

▪ Social media 

o Note the time period when each method became popular. 

2. Data Organization 



o For each communication method, write brief points on: 

▪ How it worked 

▪ Speed of communication 

▪ Advantages 

▪ Limitations 

3. Comparative Analysis 

o Compare traditional and modern communication systems in terms of: 

▪ Time taken to deliver messages 

▪ Reach (local, national, global) 

▪ Ease of use 

o Identify which developments brought the biggest change. 

4. Presentation of Findings 

o Create a timeline chart showing the chronological development of 

communication methods. 

o Prepare a comparison table highlighting key differences. 

5. Conclusion & Reflection 

o Write a short conclusion explaining how modern communication has 

influenced daily life, education, and society. 

 

Learning Outcomes 

By completing this project, students will be able to: 

• Understand the historical progression of communication systems 

• Develop research and information-gathering skills 

• Analyze and compare technological developments 

• Improve visual representation and presentation skills 

• Build awareness of the impact of communication on society 

 6. Time Speed Study (Roll no. 38-44) 

Purpose of the Project:  

The purpose of this project is to help students understand the relationship between time, 

speed, and distance through real-life measurement and calculation. By recording the time 

taken to walk between familiar locations such as home to school or different areas within the 

school, students apply mathematical concepts to everyday movement. 

This project aims to develop quantitative reasoning and calculation skills by using real 

data to compute speed and organize results in a speed–time table. Students learn how 

changes in time affect speed and how consistent or varied movement can be analyzed 

mathematically. 

Overall, the project strengthens applied mathematics, improves accuracy in measurement, 

and builds logical thinking by encouraging students to interpret numerical results and relate 

them to real-world situations. 

Detailed Instructions 



1. Selection of Route 

o Choose a fixed route for observation. This may be: 

▪ The distance between your home and school, or 

▪ The distance between two places inside the school (e.g., classroom to 

library, playground, or office). 

o Ensure the same route is used for all observations. 

2. Measurement of Distance 

o Measure the distance of the selected route using: 

▪ A measuring tape, or 

▪ Steps (later converting steps into meters), or 

▪ Google Maps (for home–school route). 

o Record the distance clearly in meters. 

3. Recording Time 

o Walk the chosen route at a normal pace. 

o Use a stopwatch or mobile timer to record the time taken in seconds or 

minutes. 

o Repeat the walk 3–5 times to improve accuracy. 

4. Data Recording 

o Create a time–speed table with columns for: 

▪ Distance 

▪ Time taken 

▪ Calculated speed 

o Calculate speed using the formula: 

Speed = Distance ÷ Time 

5. Analysis 

o Compare speeds from different trials. 

o Identify reasons for variations (fatigue, obstacles, walking pace). 

o Calculate the average speed. 

6. Conclusion 

o Write a short conclusion explaining what the data shows about your walking 

speed and how time affects speed. 

 

Learning Outcomes 

By completing this project, students will be able to: 

• Understand the relationship between distance, time, and speed 

• Apply mathematical formulas to real-life situations 

• Develop accuracy in measurement and calculation 

• Organize data systematically in tables 

• Strengthen logical reasoning and analytical skills 

• Interpret numerical data and draw meaningful conclusions 

 


